
Chapter 2. Simple UNIX comands and spreadsheets

2.1 How to use Maths computers
2.1.1 Logging in

As per when you did ‘apply’, choose a host by clicking on it (better to chose one with a lighter
load) then type the user name you chose, press return, type the password you chose when you
‘applied’, then return again.

The first time you log in, you will get to choose some KDE setups. Probably best to choose
‘Windows’ look and feel. (You can try changing to another look later.)

2.1.2 Logging OUT

The default setup in the Mathematics department is a to use KDE as the desktop. If you don’t
change that (which you can do) the ‘Logout..’ menu item in the ‘K’ menu does log you out.

2.1.3 Terminal window

The idea of a terminal window (Xterminal or Konsole window) is that you can type commands
for the system to execute (rather than doing things with a mouse and menus).

By default you will have one terminal window when you log into the Maths system. You can
open more if you like to do two things at once.

At the bottom of the screen there should be an icon of a computer screen. If you move the
mouse over it the word ‘Konsole’ will show. Click this to open a window.

Alternatively, under the ‘K’ menu, ‘Utilities’, ‘X-utilities’, you should find a menu item X
Terminal (Terminal Program). This item starts a different application to Konsole, though they do
similar things.

Yet another way is to type xterm & (followed by the return key) in a terminal window.
xterm is the name of the program and the & at the end allows the window you begin from to be
used even while the xterm window is still doing stuff.

2.1.4 Password

A standard UNIX command called passwd changes your password, in case you want to do that.
On our system, this will only work if you are on the host called salmon. If you are logged into
another host, type salmon in a terminal window and a window connected to the server called
salmon will pop up.

On salmon, type passwd (followed by the return key). You need your old password, and
then to type your new password the same way twice. The passwords are case-sensitive and
should have numbers as well as letters.

When you give your password (meaning type it), it should not be appearing on the screen
as you type. What is kept by the system is an encrypted form of the password and you need to
type the original. The system managers can see the encrypted form but not the original. If you
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forget your password, the system people can set your password afresh, but they cannot find out
the original one.

Send email to ops@maths.tcd.ie about problems with things not working. Might be
best to ask your lab tutor first.

2.1.5 Some useful commands and concepts

Here are some things you can type in a terminal window, and roughly what effect they have.
In the ‘K’ menu, there are many options. All those options and more can be controlled by
commands you type in a window.

In the UNIX world the inventors were apparently not such good typists because they tried to
use 2-letter commands for everything. Some of the abbreviations are maybe hard to guess, and
there are by now many things with longer names that two letters.

ls ‘List sorted’. Shows you a list of the file names and subfolder names in the current working
directory (or folder). Depending on how things are set up, you may see different colours
on the names of different types of things.

ls -l Shows you a list of the file names together with dates and some other ‘protection’ and
size information.

x marks programs, r and w marks readable and writable. There are 3 lots of rwx places,
the first group is for the owner of the file (also shown), the next for the group the file (also
shown) belongs to and the last for every other user on the system. If there is a d at the start
it is a directory (folder).

ls -al Same as ls -l but also shows files and folders that are normally hidden (begin with
a dot).

ls -F Same as ls but shows programs with a * after them and subfolders with a / at the end
of their names.

pwd ‘Path way of the directory’. All the files on the computer are organised into folders. The
one at the top is called / (slash). You might be used to something similar in Windows
where you might see a drive C: in ‘My Computer’ and there could be a C:\ directory (or
folder).

The command pwd tells you where you are.

date Date now.

cal Calendar for this month.

cal nov 1987 Calendar for the month you were born?

man cal Manual page for the cal command — tells you loads of details you might not want
to know.

ops@maths.tcd.ie


faq Open a list of “Frequently asked questions” (and answers) about the Maths system in a web
browser. [It would be great if these answers were all up to date, but they are not.]

less /www/local/admin/faq.html Show the (text) file named in a literal way. That
file contains a list of some ‘frequently asked questions’ about the maths computer system.
Rather than looking at the raw HTML code, you could open
http://www.maths.tcd.ie/local/admin/faq.html in a browser where it
would be easier to read.

mutt Mail reading and sending programme (in text windows)

firefox

mozilla

opera Web browsers

2.1.6 How to access your maths account from home

Sometimes people want to read their email or access their maths account from home or from
elsewhere in College. There are quite a few options.

• There is a web method to access your mail in maths at https://webmail.maths.
tcd.ie. [We should have a proper security certificate but we do not.]

The facilities should be very vaguley similar to those on http://myzone.tcd.ie.

• From windows computers in College there is a utility called ssh installed and you can get to
your maths account (in text mode) by connecting to (for example) walton.maths.tcd.ie

The windows ssh also offers a file window (where you can see your files on the local and
remote computers) and copy files from one place to the other by dragging them across with
the mouse.

• There is a free version of the ssh utility for windows called putty.exe and you could
download it to your computer at home. It is not big and does not take long to download.
You should be able to find it with Google.

• There is a version of ssh available for web use at http://www.maths.tcd.ie/ssh
and you could possibly use that from home or an internet cafe. However, it requires java
and can be difficult to get to work.

• Many mail programs can be configured to read mail via a protocol called imap. There is
an imap server at host imap.maths.tcd.ie

Thunderbird is a program that can work in this way.
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2.2 A little on Spreadsheets

Spreadsheets are computer versions of an accounts ledger. They are used frequently in business,
but have wider uses. In particular they are often used to manipulate experimental data (in some
fields other tools are more often used) and you may encounter them in your labs. The idea then
is to give you a rudimentary knowledge of spreadsheets so that you may know where to start if
you need to use on in the lab.

First where do you find a spreadsheet programme to use? People usually assume that you
have one on your computer, called Microsoft Excel, and maybe even use the word “Excel” rather
than “spreadsheet”. However, if you have a computer at home it would possibly have cost you
extra to get Excel (and PowerPoint) for it. I think you need Microsoft Office Professional to
get them, at least if you got your computer after some date like the year 2000. At one stage
Windows computers tended to have all this software on them whether you really wanted them
or not, but that is no longer automatic. And Macintosh or Linux computers possibly won’t have
Excel (again unless someone takes care to get it). The PCs and Macs in the College computer
labs do have Excel.

There are alternatives to Excel that do more or less the same job, at least up to some level
of sophistication. I think OpenOffice is a good option. You can download it for free from
www.openoffice.org and it will give you a replacement for Microsoft Office (Word, Excel
and Powerpoint at least; it can read and write [most] files from Microsoft programmes.1 I sup-
pose downloading OpenOffice is easy if you have a broadband connection, but maybe painful
otherwise. (For Windows it seems to need to download a file of 93MB.)

There are other options too, including several other options for downloading spreadsheet
programs that you don’t have to pay for. Another option you might find interesting is that if
you have a gmail account you can use a Google spreadsheet online. (As your TCD email
account is on gmail, I think you must all have access to Google spreadsheets.) As far as I can see
the facilities provided by Google spreadsheets have been extended in the past year. They were
limited to basic manipulations, but can now do graphics (bar charts and pie charts and stuff) and
quite likely will get more features as time goes by.

2.1 What a spreadsheet looks like. When you start a spreadsheet programme (with nothing
saved from before) you should see a grid like the one in the next picture. There are various menu
items across the top, various magic shortcut icons around the top and side, and the essence of the
thing is the grid. The rows of the grid are numbered 1, 2, 3, and so on, while the columns are
labels A, B, C, etc. You would normally see a bigger number of rows and columns than what is
shown here.

1I’m not sure how things work with Office 2007. I’m pretty sure the files saved by Office 2007 and associated
Word, Excel, PowerPoint will need to be converted somehow to be read by older Office versions. And this same
issue may arise with OpenOffice, at least for a while.

www.openoffice.org
gmail
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The little tabs at the bottom called sheets allow you to have several pages, like in a ledger
book, with separate or related stuff on the other sheets. But we will just try to explain what you
can do sticking with one sheet.

In the picture the top left box, the one in Column A and Row 1, is highlighted (or selected), as
indicated by the blackened square around that box, and also you can see A1 written somewhere
above. What you can do is put stuff in the different boxes. We call these boxes cells of the
spreadsheet and the (main) things you can put in these cells are

(i) a number

(ii) a word or some words, or any text
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(iii) a formula

In this way it is like a ledger book you might have seen someone use for accounts, except
that the formula option is different. You might think the boxes are too small to enter much text
but you can resize the columns (make them wider or narrower) by dragging with your mouse on
the boundary between columns across the top (where the A, B, C, etc. are). You can also make a
row deeper, or get the thing to ‘wrap’ lines in a cell and then resize rows automatically to fit the
deepest cell in that row.

You do these things with the Format → Cells menu item. To get the line to wrap under itself
at word breaks, you pick the ‘Alignment’ tab in that menu and check the box for ‘Automatic line
break’.

But to get some words in (or a number) just type the number with some particular cell se-
lected. Type Return or press Tab when you are done.

You can move round to different cells by clicking on them with the mouse, or with arrow
keys.

The real power of a spreadsheet comes from the ability to enter formulae into cells, and
the possibility that the formulae can read values out of other cells. The first rule is that a cell
beginning with an equals sign is interpreted as a formula. (If you happen to try entering text
that begins with an equals sign, such as =Total you will get a peculiar outcome, indicating an
error.) If you type in, say =5+6 (and press return), 11 will show in the cell. When you click on
the cell, the actual formula will still be there, but it looks just like you typed in the 11 for the rest
of the time.

You can put arithmetic formulae using + for addition, - for subtraction, * for multiplica-
tion, / for division and ˆ for “to the power of”. You use round brackets for grouping. So
=(5+6/9)*8 will come out to 45.33333333. You can also use lots of standard functions,
too many to list here. The notation is like =sin(1.2) although the function names are case-
insensitive (so that =SIN(1.2) and =Sin(1.2) will do the same).

The real advantage of a spreadsheet is that formulae and functions can refer to values entered
in (or computed) in other cells. So say in cell B5 (meaning the one in column B, row 5) we have
entered in 1.2) and then in cell D5 we enter in =sin(B5). Cell D5 will then show the value
of sin 1.2 (which is 0.932039). But if you later change the entry in B5, the value in cell D5 will
automatically change accordingly.

Another helpful thing is how copy and paste works. If you want to replicate what is in cell
B5 all the way down column B, from cell B6 to B15, this is what you can do. Highlight (or click
on) cell B5. Using the Edit menu, copy that cell (or just use the keyboard shortcut Control-C).
Then drag your mouse from cell B6 down to cell B15. When you let up the mouse button those
cells will still be highlighted. Press Paste (in the Edit menu, or the keyboard shortcut Control-V)
and what is in cell B5 will be copied into each of the positions B6 down to B15.

Now if, as seems to be the case above, cell B5 just contains a fixed value 1.2, this is a minor
convenience. Easier than retyping the number 1.2 ten times. (If you did it in cells B6 down to
cell B105 it would save you typing 1.2 a hundred times.) But, now comes the value of what is
called ‘relative references’. Suppose we copy cell D5 (where we had entered =sin(B5)) in the
same way, and paste it into cells D6 down to cell D15. What goes into the cells is then changed
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so that the reference is changed in each one. In cell D6, it will become the formula =sin(B6),
on the grounds that B6 is in the same position (2 cells left) relative to cell D6 as cell B5 is to
cell D6.

2.2 Example. Suppose we want to calculate the values of y = cos(x) for x = 0, π/10, 2π/10,
. . . , 20π/10 = 2π. (Maybe we want these values for a graph.)

In fact for this kind of mathematical graph, spreadsheets are probably not what you should
use. But we’ll use it now for this anyhow.

Let’s enter this in the cells

A B
1 0 =cos(A1)
2 =A1 + pi()/10
3
4
5
6
7
8
9

10

(Here the pi() is a way to get at the value π = 3.1415 . . ..) This is what you will see

A B
1 0 1
2 0.31
3
4
5
6
7
8
9

10

Now copy cell A2 and paste it into all the positions A3 to A21. And copy cell B1 and paste that
into all the positions B2 to B21. Just to clarify, the effect will be the same as if you had typed all
the formulae in the left side of the following, but what you see will be like the right.
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A B
1 0 =cos(A1)
2 =A1 + pi()/10 =cos(A2)
3 =A2 + pi()/10 =cos(A3)
4 =A3 + pi()/10 =cos(A4)
5 =A4 + pi()/10 =cos(A5)
6 =A5 + pi()/10 =cos(A6)
7 =A6 + pi()/10 =cos(A7)
8 =A7 + pi()/10 =cos(A8)
9 =A8 + pi()/10 =cos(A9)

10 =A9 + pi()/10 =cos(A10)
...

21 =A20 + pi()/10 =cos(A21)

A B
1 0 1
2 0.31 0.95
3 0.63 0.81
4 0.94 0.59
5 1.26 0.31
6 1.57 0
7 1.88 -0.31
8 2.2 -0.59
9 2.51 -0.81

10 2.83 -0.95
...

21 6.28 1

2.3 Absolute references. We may sometimes want to refer to a fixed value, like a tax rate or a
VAT rate in a spreadsheet. Or maybe the concentration for some acid, or a PH value. But we
might want to allow for that value being changed, and then we want to be able to change our
calculations accordingly.

We could find a place where we are going to put that value, say cell D2. We could enter 1.21
into that cell for the multiplying factor to add VAT. Now in column A we might list a description
of various items we spent money on, in the next column B the cost before VAT of those things,
and in column C we might want the cost including VAT. We could enter in cell C1 the formula
=B1*1.21 and copy that down column C. That would work, but if we have to change the VAT
rate we would have to alter all the formulae. If we put =B1*D2 in cell C1, and copy that to cell
C2, it will become =B2*D3, but that is not what we want. We want to get the value in B2 times
the value in D2.

This can be done by inserting in cell C1 the formula =B1*$D$2. The $D$2 reference stays
as $D$2 even after it is copied and pasted. So now if we paste that into cell C2, it will become
=B2*$D$2, and still refer to the constant 1.21 we have entered in cell D2.

Let’s say we create this spreadsheet,

A B C D
1 Item Cost ex VAT Cost inc VAT VAT Rate
2 Door 97.32 =B2*$D$2 1.21
3 Lock 23.55 =B3*$D$2
4 Brass handle 18.35 =B4*$D$2
5 Hinges 15.19 =B5*$D$2
6 =B6*$D$2
7 =B7*$D$2
8 =B8*$D$2
9 =B9*$D$2

10 TOTAL =sum(B2:B9) =sum(C2:C9)
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where we are showing what was typed into each cell. However, cells C3 to C9 could be arrived
at by copying and pasting from cell C2. It would not save you much, but cell C10 could also be
got by copying and pasting from cell C9.

The result you would see on the screen would look something like this:

A B C D
1 Item Cost ex VAT Cost inc VAT VAT Rate
2 Door 97.32 117.76 1.21
3 Lock 23.55 28.5
4 Brass handle 18.35 22.2
5 Hinges 15.19 18.38
6 0
7 0
8 0
9 0

10 TOTAL 154.41 186.84

You might fill in further items and their costs into columns A and B (rows 6 to 9 are still free).
As you do that the totals will be updated. Changing the VAT rate entry 1.21 would change the
numbers in column C.

You might also want to adjust the formatting on the cells B2 to C10 to show 2 decimal places
and a perhaps a currency symbol. There are too many tricks you can do to even pretend to tell
you about them.

2.4 Further features. As mentioned already, spreadsheets can do such a range of things that we
can’t really hope to convey many of the finer points.

The ability to show things graphically is often used. The idea is that you select (by dragging
the mouse over a row, a column, or a rectangle) data for your graph. You then select the menu
item ‘Insert → chart’ (or click on a little icon that conveys a chart) and what happens next is
supposed to explain itself. You can do bar charts, pie charts, multiple graphs on one plot, choose
various kinds of labels or colours. As you go you will see a hint of what your final outcome is
going to look like. You should look carefully at what you get to see if it is what you want. I’m
sure they are always ‘right’, but maybe what is going on is more obvious from an accounting or
business point of view than from a scientific or mathematical perspective.

About functions that spreadsheets know about. There are really lots, too many to try and
explain. Anyhow we don’t have the background to understand them all (especially those related
to statistics). Here is a small selection

cos(), sin(), exp(), . . . Lots of mathematical functions. exp(x) means ex. cos(x) is the cos x we
use in calculus (with x in radians).

sum() Adds up the numerical values in the range. Could be =sum(A1:B10,C3)

average() Divides the sum of the numerical values in the range by the number of them.
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count() Counts how many numerical values there are in the range.

So =sum(A1:B10)/count(A1:B10) should be the same as =average(A1:B10)

counta() Counts how many not blank entries there are in the range. So a cell with text in it will
count.

max(), min() Picks the largest (smallest for min) value among those you feed it.

if() This allow for complicated things.

A simple example is the formula =IF (A2>39,"Pass","Fail")

It means if the value if A2 is more than 39, then put the word Pass. If not, put the word
Fail. Instead of words, you could have formulae. You could programme a rule that charges
20% tax up to 1500 euro and 40% on anything above like this
=IF (A2>1500, 0.2*1500 +0.4*(A2-1500), 0.2*A2)

There are help menus in all spreadsheets I’ve seen recently and there are also menus you can
put up showing all the available functions (of which there are a few hundred predefined).

Richard M. Timoney October 17, 2007
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